
ACCESS 2021/365 
LEVEL 1 

Assessment: Database terms 

1. What reduces redundant data? 
a. Normaliza:on 
b. Reference Integrity 
c. Metadata 
d. Indexing 

2. Which is a field or fields that link back to more informa:on in a related table. 
a. Primary key 
b. Related key 
c. Foreign key 
d. Index key 

Assessment answers: Database terms 

1. What reduces redundant data? 
a. Normaliza*on 
b. Reference Integrity 
c. Metadata 
d. Indexing 

2. Which is a field or fields that link back to more informa:on in a related table. 
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d. Index key 

Assessment: Rela:onal Databases 

1. An Excel spreadsheet is what kind of a database? 
a. Rela:onal 
b. NoSQL 
c. Flat file 
d. It’s not a database 

2. Which database type was developed for use over the web? 
a. NoSQL 
b. SQL 
c. WebDB 
d. Flat file 
e. Index key 



Assessment answers: Rela:onal Databases 

3. An Excel spreadsheet is what kind of a database? 
a. Rela:onal 
b. NoSQL 
c. Flat file 
d. It’s not a database 

4. Which database type was developed for use over the web? 
a. NoSQL 
b. SQL 
c. WebDB 
d. Flat file 

Assessment: Access interfaced and objects 

1. What is the file extension for an Access database? 
a. .mbdx 
b. .accds 
c. .accdb 
d. .xlsx 

2. Which is used for easier on screen input of data? 
a. Form 
b. Table 
c. Report 
d. Query 

 

Assessment answers: Access interfaced and objects 

1. What is the file extension for an Access database? 
a. .mbdx 
b. .accds 
c. .accdb 
d. .xlsx 

2. Which is used for easier on-screen input of data? 
a. Form 
b. Table 
c. Report 
d. Query 

Assessment: Crea:ng tables 

1. You can create tables only in table Design view.  True or false? 
a. True 
b. False 

2. Which of the following are examples of table proper:es?  Choose all answers that apply. 
a. Sort order 



b. Primary key 
c. Filtering 
d. Rela:onships 

Assessment answers: Crea:ng tables 

1. You can create tables only in table Design view.  True or false? 
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b. False 

2. Which of the following are examples of table proper:es?  Choose all answers that apply. 
a. Sort order 
b. Primary key 
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Assessment: Crea:ng fields 

1. In Which view can you enter filed data? Choose then one correct answer.? 
a. Datasheet view 
b. Table Design view 

2. How many fields can you have in a single table? Choose the one correct answer. 
a. 10 
b. 12 
c. 144 
d. 255 

3. Which of the following are proper:es that are common to all field types? Select all correct 
answers. 

a. Required 
b. Decimal places 
c. New values 
d. Cap:on 

4. When you create a new table, Access always assigns a default primary key?  True or false? 
a. True 
b. False 

 

Assessment answers: Crea:ng fields 

1. In Which view can you enter filed data? Choose then one correct answer.? 
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3. Which of the following are proper:es that are common to all field types? Select all correct 
answers. 

a. Required 
b. Decimal places 
c. New values 
d. Cap*on 

4. When you create a new table, Access always assigns a default primary key?  True or false? 
a. True 
b. False 

Assessment: Data valida:on 

1. It is generally be\er to perform valida:on on tables rather than on forms?  True or false? 
a. True 
b. False 

2. You always use filed proper:es to perform data valida:on in tables. True or false? 
a. True 
b. False 

3. Default values for fields cannot be changed by the user when entering data. Tru Cor false? 
a. True 
b. False 

4. Which of the following would you use to display a message to users while entering data? Select 
the one correct answer. 

a. Valida:on text 
b. Cap:on property of a field 

 

Assessment answers: Data valida:on 

1. It is generally be\er to perform valida:on on tables rather than on forms?  True or false? 
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2. You always use filed proper:es to perform data valida:on in tables. True or false? 
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b. Cap*on property of a field 

Assessment: Rela:onships and keys 



1. You can change the primary key in a table from the AutoNumber ID field to some other field.  
True or false? 

a. True 
b. False 

2. A primary key can be based on which of the following? Select the single best answer. 
a. Only on a single field. 
b. On one or a combina:on of two fields. 
c. On any number of fields in the table. 

3. Is it appropriate to use social security numbers as a primary field? 
a. Yes 
b. No 

Assessment answers: Rela:onships and keys 
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Assessment: Crea:ng basic queries 

1. What query type has an output similar to that of a spreadsheet`? Choose the best answer. 
a. Append 
b. Crosstab 
c. Parameter 
d. Totals 

2. You’re reviewing a query that displays order details.  Below the Category field there are two 
Criteria on two separate row:.  “Beverages” and “Produce”.  What results will the query show? 
Choose the best response. 

a. All orders with items in both the Beverages and Produce categories. 
b. All orders with items in either the Beverages and Produce categories. 
c. All orders with Beverages but no Produce or Produce but no Beverages. 
d. No orders at all. 

3. It’s oben best prac:ce to add data to parameters, but it depends on the field type.  True or false? 
a. True 
b. False 

4. Which type of query might not work because of tables rela:onships rules?  Choose the best 
response. 



a. Append 
b. Delete 
c. Make Table 
d. Update 
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Assessment: Modifying queries 

1. What field type can’t you choose a pre-made format op:on for in the Property Sheet pane? 
Choose the best response. 

a. Date/Time 
b. Number 
c. Text 
d. All the above 

2. To sort by mul:ple values, you might need to rearrange the order of the fields in your query.  
True or false? 

a. True 
b. False 

3. It’s oben be\er to hide a query field rather than just dele:ng it? True or false? 
a. True 
b. False 

4. One of the entries in your CustomerName list is “Century Grocers”. Which VBA string func:on 
would display it as “Century” in a query? 



a. Leb([CustomerName],7) 
b. Right([CustomerName],7) 
c. TrimCustomerName]) 
d. Ucase([CustomerName]) 

Assessment answers: Modifying queries 

1. What field type can’t you choose a pre-made format op:on for in the Property Sheet pane? 
Choose the best response. 

a. Date/Time 
b. Number 
c. Text 
d. All the above 

2. To sort by mul:ple values, you might need to rearrange the order of the fields in your query.  
True or false? 

a. True 
b. False 

3. It’s oben be\er to hide a query field rather than just dele:ng it? True or false? 
a. True 
b. False 

4. One of the entries in your CustomerName list is “Century Grocers”. Which VBA string func:on 
would display it as “Century” in a query? 

a. LeM([CustomerName],7) 
b. Right([CustomerName],7) 
c. TrimCustomerName]) 
d. Ucase([CustomerName]) 

Assessment: Using calculated fields 

1. Why is it be\er to put calculated fields in queries than in tables? Choose all that apply. 
a. It’s easy for data to become out of sync due to later changes. 
b. It’s much more work to enter a calculated field in a table than in a query. 
c. Table  data should never be edited directly. 
d. Table structures should be kept as simple as possible. 

2. In Expression builder, how would you write a reference to the EmployeeID field? 
a. “EmployeeID” 
b. {EmployeeID} 
c. <<EmployeeID>> 
d. [EmployeeID] 

3. In a calculated text field, you don’t need to do anything special to add a numeric value to a text 
string.  True or false? 

a. True 
b. False 
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Assessment: Forms 

1. True or false? Of the four basic database opera:ons, forms can handle crea:on, dele:on, and 
bilateral recalcitrance. 

a. True 
b. False 

2. Which of the following statements about forms is correct? 
a. An unbound form is always :ed to mul:ple tables. 
b. A bound form is :ed to a specific data source. 
c. A query is a type of form bound to a specific data source. 
d. A split form is used to input mul:ple tables. 

3. Layout view allows you to edit your form and see actual live data simultaneously. 
a. True 
b. False 

4. Which view allows you to edit all forms proper:es as well as a header/footer? 
a. Datasheet view 
b. Layout view 
c. Form view 
d. Design view 

5. When adding fields to a form, you select one or more field names in the Selected Fields list and 
add them to the Available list. 

a. True 
b. False 

Assessment answers: Forms 
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b. A bound form is *ed to a specific data source. 
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d. A split form is used to input mul:ple tables. 

3. Layout view allows you to edit your form and see actual live data simultaneously. 
a. True 
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5. When adding fields to a form, you select one or more field names in the Selected Fields list and 
add them to the Available list. 
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Assessment: Form design 

1. From which central loca:on can you change for proper:es? 
a. The Form Design pane. 
b. The Form Proper:es window. 
c. The Property Design window. 
d. The Property Sheet pane. 

2. By default, a form’s proper:es are listed in alphabe:cal order. 
a. True 
b. False 

3. Which of these statements is correct? 
a. The Data tab is where you choose what and how records are displayed. 
b. Seong a property’s value to NO means the user cannot select a record. 
c. The Filter property shows a subset of records designed by the Order By property. 
d. Double-clicking the Form Footer bar creates addi:onal space to add controls. 

4. Only one set of controls is displayed in the Details sec:on, which in turn represents a single data 
record. 

a. True 
b. False 

Assessment answers: Form design 
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3. Which of these statements is correct? 
a. The Data tab is where you choose what and how records are displayed. 
b. Seong a property’s value to NO means the user cannot select a record. 
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Assessment: Form controls 

1. Which of the following statements about form control is incorrect? 
a. The Use Control Wizards op:on is located in the Control design gallery. 
b. Layout view and Design view offer a wide variety of controls in the Design tab’s Control 

group. 
c. Each control must have a unique name, which you must assign to it. 
d. You can always change a control’s size aber the fact by selec:ng and resizing it. 

2. True or false? When crea:ng a List Box, when the number of choices exceeds the available 
space, scroll bars are automa:cally enabled by Access. 

a. True 
b. False 

3. Which of the following statements is incorrect? 
a. Using the List Box and Combo Boc as bound controls requires seong their Row Source 

property. 
b. A Combo Box is a drop-down box with a pre-configured list of choices, so it takes up less 

space than the other list controls. 
c. An Op+on Group creates a set of bu\ons in which the user is permi\ed to pick exactly 

one. 
d. With the List Box, users cannot add their own choices; however, you can manually 

change this default seong. 
4. True or false? To add a command bu\on to a form, you must manually create an underlying 

macro or write SQL statements. 
a. True 
b. False 

5. Which of the following is incorrect? 
a. Access sets the tab order for each control you add to the form to one number higher 

than the previous control. 
b. Aber you’ve created a form, if you change the order of its controls, you must manually 

change the tab order of each control. 
c. It’s best to do all your alignment, posi:oning, and spacing work first, and then set the 

tab order. 
d. Tabbing from field to field, instead of using the mouse, is far more efficient and 

expedient. 

Assessment answers: Form controls 
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Level 2 
Assessment: Crea:ng reports 

1. In which report views can you make   design changes to a report? Select all correct answers. 
a. Report view 
b. Print preview 
c. Layout view 
d. Design view 



2. Which of the following are ways to specify data sources for a report? Select all correct answers. 
a. Automa:cally using the Report bu\on with a table open. 
b. By using the Report Wizard. 
c. By using the Expression Builder for a report’s Data Source property. 

3. Which of the following approaches could you use to see only a subset of records from a table in 
a report? 

a. Use the report’s Order By property. 
b. Use the report’s Filter property. 
c. Base the report on a query. 
d. Show only certain fields in the report. 

4. The Report Wizard is quick, but does not allow you to group data in a report. True or false? 
a. True 
b. False 

 

Assessment answers: Crea:ng reports 

1. In which report views can you make   design changes to a report? Select all correct answers. 
a. Report view 
b. Print preview 
c. Layout view 
d. Design view 

2. Which of the following are ways to specify data sources for a report? Select all correct answers. 
a. Automa*cally using the Report buZon with a table open. 
b. By using the Report Wizard. 
c. By using the Expression Builder for a report’s Data Source property. 

3. Which of the following approaches could you use to see only a subset of records from a table in 
a report? 

a. Use the report’s Order By property. 
b. Use the report’s Filter property. 
c. Base the report on a query. 
d. Show only certain fields in the report. 

4. The Report Wizard is quick, but does not allow you to group data in a report. True or false? 
a. True 
b. False 

Assessment: Report controls 

1. What is the best way to ensure that a label in a report header lines up with its associated 
informa:on in the detail sec:on? Select the one best answer. 

a. Use size op:ons. 
b. Use Posi:on op:ons. 
c. Use Align op:ons. 

2. Which report sec:ons shows once for each group of data in a report? Select the best answer. 
a. Page sec:ons. 
b. Category sec:ons. 



c. Detail sec:ons. 
3. Calculated fields are useful in grouped and summary sec:ons of a report.  True or false? 

a. True 
b. False 

4. You do not need to remember field names when using the Expression Builder.  True or false? 
a. True 
b. False 

5. You can group by only one field in a report.  True or false? 
a. True 
b. False 

Assessment answers: Report controls 

1. What is the best way to ensure that a label in a report header lines up with its associated 
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Assessment: Formaong reports 

1. Which of the following are page Setup op:ons for a report? Select all correct answers. 
a. Margins 
b. Data Source 
c. Size 
d. Page Layout 
e. Background Image 

2. Images in a report do not have to come from your database. True or false? 
a. True 
b. False 

3. Which Size Mode seong is most appropriate if you want to be sure that an en:re image shows 
and is not distorted? Select the one best answer. 

a. Zoom 



b. Clip 
c. Stretch 

4. Which control type do you use to display images that come from your database? Select the one 
best answer. 

a. Image 
b. Unbound Object Frame 
c. Bound Object Frame 

5. You can customize themes and save your customiza:on for future use.  True or false? 
a. True 
b. False 

Assessment answers: Formaong reports 
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Assessment: Grouping and summarizing 

1. What aggregate func:ons shows how much individual values in a group vary from the average? 
Choose he best answer. 

a. MAX 
b. MIN 
c. VAR 
d. WHERE 

2. When you have both an Average total and an Expression total in your query, what order are they 
calculated in? Choose the best answer. 



a. Average then Expression 
b. Expression then Average 
c. Leb column the right column 
d. Having both will generate an error 

3. Having too many Group By fields in a Total query can give you very unfocused results? True or 
false? 

a. True 
b. False 
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false? 
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Assessment: Upda:ng, dele:ng, and rela:onships  

1. Cascading updates and deletes can only affect two tables at most.  True or false? 
a. True 
b. False 

2. When you perform a cascading update or delete, Access will warn you about how many records 
in the current table will be altered, but may not be clear what records in other tables will be 
affected.  True or false? 

a. True 
b. False 

Assessment answers: Upda:ng, dele:ng, and rela:onships  

1. Cascading updates and deletes can only affect two tables at most.  True or false? 
a. True 
b. False 

2. When you perform a cascading update or delete, Access will warn you about how many records 
in the current table will be altered, but may not be clear what records in other tables will be 
affected.  True or false? 



a. True 
b. False 

Assessment: Indexing for performance 

1. What is the primary purpose of an index? Choose the best answer. 
a. To speed aggregate func:ons 
b. To speed queries 
c. To speed table updates 
d. To speed table sor:ng 

2. What is true about the Unique property on an index? Choose the best answer. 
a. If a Unique index has two fields, each field must be unique in each record. 
b. If a Unique index has two fields, the combina:on of both fields must be unique in each 

record. 
c. There can be only one field in a Unique index. 
d. There can be only one Unique index per table. 

3. One of the main benefits of indexing is that it’s as easy to index a long text field as it is to index a 
numeric field.  True or false? 

a. True 
b. False 

Assessment answers: Indexing for performance 
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record. 
c. There can be only one field in a Unique index. 
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3. One of the main benefits of indexing is that it’s as easy to index a long text field as it is to index a 
numeric field.  True or false? 

a. True 
b. False 

 

Assessment: Specialized query types 

1. What kind of query might be wri\en in T-SQL?  Choose the best response. 
a. Data Defini:ons 
b. Pass through 
c. Either 



d. Neither 
2. Data Defini:on Queries are not actually executed in Access.  True or false? 

a. True 
b. False 

3. Which of the following is true about Pass Through Queries? Choose all that apply. 
a. They can be must faster than queries wri\en for the Access engine. 
b. They only provide you with read-only records. 
c. You can only run Select queries. 
d. You can run Select or Append queries. 
e. You can run Select or Make table queries. 

 

Assessment answers: Specialized query types 

1. What kind of query might be wri\en in T-SQL?  Choose the best response. 
a. Data Defini:ons 
b. Pass through 
c. Either 
d. Neither 

2. Data Defini:on Queries are not actually executed in Access.  True or false? 
a. True 
b. False 

3. Which of the following is true about Pass Through Queries? Choose all that apply. 
a. They can be must faster than queries wriZen for the Access engine. 
b. They only provide you with read-only records. 
c. You can only run Select queries. 
d. You can run Select or Append queries. 
e. You can run Select or Make table queries. 

Assessment: Subforms 

1. A subform displays related records from the “one” side of a one-to-many rela:onship. 
a. Ture 
b. False 

2. Which of these statements are incorrect? Choose all that apply. 
a. The main form and subform contain proper:es you use to tell Access what fields links 

the two together. 
b. Once those proper:es are set, you must sync the two forms manually. 
c. Any :me you choose to include fields from two or more tables, the Form Wizard 

automa:cally creates a form with the subform. 
d. If you rename a subform later, its link to the main form automa:cally updates. 

3. When using an exis:ng form as a subform, if the two forms aren’t synchronized, you must delete 
the form and start the procedure from scratch. 

a. True 
b. False 

4. Which of the following statements is incorrect? 



a. If an exis:ng form has a subform of its own, using it as a subform results in each subform 
having a simple one-to-one rela:onship with main form. 

b. A linked form allows you to choose the related data you wish to view, rather than having 
the poten:al clu\er and confusion of viewing mul:ple subforms. 

c. To use an exis:ng form as a subform, drag the form you want to use as a new subform 
from the naviga:on pane onto the main form. 

d. When linking forms, the original form is called the “first form,” and the new, linked 
subform is the “second form.” 

 

Assessment answers: Subforms 

1. A subform displays related records from the “one” side of a one-to-many rela:onship. 
a. Ture 
b. False 

2. Which of these statements are incorrect? Choose all that apply. 
a. The main form and subform contain proper:es you use to tell Access what fields links 

the two together. 
b. Once those proper*es are set, you must sync the two forms manually. 
c. Any :me you choose to include fields from two or more tables, the Form Wizard 

automa:cally creates a form with the subform. 
d. If you rename a subform later, its link to the main form automa*cally updates. 

3. When using an exis:ng form as a subform, if the two forms aren’t synchronized, you must delete 
the form and start the procedure from scratch. 

a. True 
b. False 

4. Which of the following statements is incorrect? 
a. If an exis*ng form has a subform of its own, using it as a subform results in each 

subform having a simple one-to-one rela*onship with main form. 
b. A linked form allows you to choose the related data you wish to view, rather than having 

the poten:al clu\er and confusion of viewing mul:ple subforms. 
c. To use an exis:ng form as a subform, drag the form you want to use as a new subform 

from the naviga:on pane onto the main form. 
d. When linking forms, the original form is called the “first form,” and the new, linked 

subform is the “second form.” 

Assessment: Advanced controls 

1. Which of the following statements is/are incorrect? Choose any or all that apply. 
a. A hyperlink object allows you to link to other des:na:ons, including other database 

objects, an email, a file, or a webpage. 
b. It allows you to link to an email, a file, or a webpage, but not to other database objects. 
c. When linking to an email address, any text in the “text to display” box becomes the 

Cap:on property. 
d. When linking to a web address, the value from the parameter “_dpw” in the website 

URL displays in the search box and executes the search automa:cally. 



2. True or false? A distrac:on is an easy way to expose func:onally to end users that hides the 
complex, sophis:cated manner in which the underling code runs. 

a. True 
b. False 

3. Which of these statements is/are correct? Choose any or all that apply. 
a. The tools for adding as a\achment control to a form are located in the Design tab’s Tool 

group. 
b. A\achments can also be added, removed, or opened for edi:ng from the Auxiliary Files 

window. 
c. The tools for adding an a\achment control to a form are located in the Design tab’s 

Controls gallery. 
d. The real benefit of a chart control is that its chart can automa:cally update as the data 

in its underlying records change. 
4. True or false? If you don’t like the look and feel of your chart, you can use the Microsob Graphics 

applica:on within Access, where you can directly edit your charts details. 
a. Ture 
b. False 
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URL displays in the search box and executes the search automa:cally. 
2. True or false? A distrac:on is an easy way to expose func:onally to end users that hides the 

complex, sophis:cated manner in which the underling code runs. 
a. True 
b. False 

3. Which of these statements is/are correct? Choose any or all that apply. 
a. The tools for adding as aZachment control to a form are located in the Design tab’s 
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window. 
c. The tools for adding an aZachment control to a form are located in the Design tab’s 

Controls gallery. 
d. The real benefit of a chart control is that its chart can automa*cally update as the data 

in its underlying records change. 
4. True or false? If you don’t like the look and feel of your chart, you can use the Microsob Graphics 

applica:on within Access, where you can directly edit your charts details. 
a. True 



b. False 

Assessment: Subreports 

1. Subreports do not have to be linked to the main report that contains them.  True or false? 
a. True 
b. False 

2. Which of the following are ways to create a report with a subreport? Choose all correct answers. 
a. On the Create tab, click the Subform/Subreport bu\on. 
b. Place a Subform/sunbeport control on an exis:ng report. 
c. Use the Report Wizard. 
d. Drag table, query, or report objects on an exis:ng report. 

3. There is never a good reason to have unrelated subreports in the same main report. True or 
false? 

a. True 
b. False 
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1. Subreports do not have to be linked to the main report that contains them.  True or false? 
a. True 
b. False 

2. Which of the following are ways to create a report with a subreport? Choose all correct answers. 
a. On the Create tab, click the Subform/Subreport bu\on. 
b. Place a Subform/sunbeport control on an exis*ng report. 
c. Use the Report Wizard. 
d. Drag table, query, or report objects on an exis:ng report. 

3. There is never a good reason to have unrelated subreports in the same main report. True or 
false? 

a. True 
b. False 

Assessment: Advanced grouping  

1. You can use the Report Wizard group by date range such as months, quarters, and years.  True or 
false? 

a. True 
b. False 

2. Renaming totals usually go to the Detail sec:on of the report.  True or false? 
a. True 
b. False 

3. In which of the following objects can you use running sums? Choose all correct answers. 
a. Tables 
b. Forms 
c. Queries 
d. Reports 



Assessment answers: Advanced grouping  

1. You can use the Report Wizard group by date range such as months, quarters, and years.  True or 
false? 

a. True 
b. False 

2. Renaming totals usually go to the Detail sec:on of the report.  True or false? 
a. True 
b. False 

3. In which of the following objects can you use running sums? Choose all correct answers. 
a. Tables 
b. Forms 
c. Queries 
d. Reports 

Assessment: Advanced formaong 

1. Banded colors are available for each sec:on of a report.  Ture or false? 
a. Ture 
b. False 

2. Which func:on will show the user of the report’s name in a report. Choose the one correct 
answer. 

a. User() 
b. Login() 
c. CurrentUser() 
d. CurrentLogin() 

3. Which Picture Type property value should you use if you want to store an image with your 
database? Select the one correct answer. 

a. Linked 
b. Embedded 

Assessment answers: Advanced formaong 

1. Banded colors are available for each sec:on of a report.  Ture or false? 
a. Ture 
b. False 

2. Which func:on will show the user of the report’s name in a report. Choose the one correct 
answer. 

a. User() 
b. Login() 
c. CurrentUser() 
d. CurrentLogin() 

3. Which Picture Type property value should you use if you want to store an image with your 
database? Select the one correct answer. 

a. Linked 
b. Embedded 



Assessment: Crea:ng basic macros 

1. OpenTable is an example of what? Choose the best answer. 
a. An ac:on 
b. An event 
c. A macro 
d. an op:on 

2. You have a form that uses both an embedded macro and a macro object.  Which of the following 
are true? 

a. If you copy a form to another database, the embedded macro won’t automa:cally come 
along. 

b. If you copy a form to another database, the embedded macro object won’t 
automa:cally come along. 

c. If you delete the form, the embedded macro will be deleted with it. 
d. If you delete the form, the macro object will be deleted with it. 
e. Both are easy to reuse anywhere in the database. 

3. On Click is an example of what?  Choose the best response. 
a. An ac:on 
b. An event 
c. A macro 
d. an op:on 

4. You can make sure certain condi:ons are met before a table record is successfully updated by 
using a Before Change embedded macro.  True or false? 

a. True 
b. False 

Assessment answers: Crea:ng basic macros 

1. OpenTable is an example of what? Choose the best answer. 
a. An ac*on 
b. An event 
c. A macro 
d. an op:on 
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a. If you copy a form to another database, the embedded macro won’t automa:cally come 
along. 

b. If you copy a form to another database, the embedded macro object won’t 
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c. If you delete the form, the embedded macro will be deleted with it. 
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e. Both are easy to reuse anywhere in the database. 
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d. an op:on 
4. You can make sure certain condi:ons are met before a table record is successfully updated by 

using a Before Change embedded macro.  True or false? 
a. True 
b. False 

Assessment: Using variables 

1. A macro you’re reading opens with a SetTempVar statement. Without reading anything else, 
what can you say about the variable it creates? Choose all that apply. 

a. It can be used in any macro. 
b. It can be used only in this macro. 
c. Its value could be any valid expression. 
d. It will be automa:cally deleted when the macro finishes. 
e. It may s:ll be in memory aber the macro finishes. 

2. When you’re seong a variable’s value, you want to add a custom expression from the VBA 
module.  Which Expression Builder node should you look in? Choose the best response. 

a. Common Expressions 
b. Func:ons 
c. databaseName.accdb 
d. operators 

3. In Access, all variables must be declared at the beginning of the macro.  True or false? 
a. True 
b. False 

Assessment answers: Using variables 

1. A macro you’re reading opens with a SetTempVar statement. Without reading anything else, 
what can you say about the variable it creates? Choose all that apply. 

a. It can be used in any macro. 
b. It can be used only in this macro. 
c. Its value could be any valid expression. 
d. It will be automa:cally deleted when the macro finishes. 
e. It may s*ll be in memory aMer the macro finishes. 

2. When you’re seong a variable’s value, you want to add a custom expression from the VBA 
module.  Which Expression Builder node should you look in? Choose the best response. 

a. Common Expressions 
b. Func*ons 
c. databaseName.accdb 
d. operators 

3. In Access, all variables must be declared at the beginning of the macro.  True or false? 
a. True 
b. False 

Assessment: Trouble shoo:ng Macros 

1. Which OnError op:on is the same as not using an OnError statement at all?   



a. Fail 
b. Macro name 
c. Next 
d. None of the Above 

2. You want an error message to display the descrip:on generated by the error itself.  What 
expression element would you use in the MessageBox ac:on? Choose the best response. 

a. [Diagnos:ce].[Descrip:onm] 
b. [MacroError].[Descriop:on] 
c. [OnError].[Descrip:on] 
d. [USysApplica:onLog].[Descrip:on] 

3. A logic error is any error that causes the macro to stop and generate an error message. True or 
false? 

a. True 
b. False 

Assessment answers: Trouble shoo:ng Macros 

1. Which OnError op:on is the same as not using an OnError statement at all?   
a. Fail 
b. Macro name 
c. Next 
d. None of the Above 

2. You want an error message to display the descrip:on generated by the error itself.  What 
expression element would you use in the MessageBox ac:on? Choose the best response. 

a. [Diagnos:ce].[Descrip:onm] 
b. [MacroError].[Descriop*on] 
c. [OnError].[Descrip:on] 
d. [USysApplica:onLog].[Descrip:on] 

3. A logic error is any error that causes the macro to stop and generate an error message. True or 
false? 

a. True 
b. False 

Assessment: Compact & Repair 

1. True or false? Running Compact & Repair can eliminate problems caused by temporary, unused, 
and deleted objects, but can’t fix a corrupted a database. 

a. Ture 
b. False 

2. Which of the following statements is/are incorrect? Choose all that apply. 
a. Temporary objects remain part of a database only un:l you close it. 
b. When you delete database objects, the file space reserved for them isn’t automa:cally 

freed up. 
c. Access isn’t necessarily the best tool for environments in which many users must have 

simultaneous access to a single  database. 



d. It’s important to be able to run Compact & Repair during :mes when mul:ple users 
have access to a single database via a network, to ensure that all problems are resolved. 

3. True or false? It’s a good idea to back up your database prior to running Compact & Repair. 
a. True 
b. False 
c. False 

Assessment answer: Compact & Repair 

4. True or false? Running Compact & Repair can eliminate problems caused by temporary, unused, 
and deleted objects, but can’t fix a corrupted a database. 

a. Ture 
b. False 

5. Which of the following statements is/are incorrect? Choose all that apply. 
a. Temporary objects remain part of a database only un*l you close it. 
b. When you delete database objects, the file space reserved for them isn’t automa:cally 

freed up. 
c. Access isn’t necessarily the best tool for environments in which many users must have 

simultaneous access to a single  database. 
d. It’s important to be able to run Compact & Repair during :mes when mul:ple users 

have access to a single database via a network, to ensure that all problems are resolved. 
6. True or false? It’s a good idea to back up your database prior to running Compact & Repair. 

a. True 
b. False 

Assessment: Backup & Restore 

1. Which of these statements is/are correct. Choose all that apply. 
a. If there’s an object with the same name already in the database. Access will import it by 

overwri:ng the object with same name. 
b. To restore a prior version of a database, click Remembrance of Database Past. 
c. To restore a prior version of a database, click Restore Database. 
d. It’s important to rename any imported objects, otherwise ac:ons related to them will 

not func:on correctly. 

Assessment answers: Backup & Restore 
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overwri:ng the object with same name. 
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d. It’s important to rename any imported objects, otherwise ac*ons related to them will 

not func*on correctly. 

Assessment: Other maintenance tasks 



1. True or false? If a database is password protected, and the password is forgo\en, then only way 
to restore the file is by obtaining the password through Microsob Support. 

a. True 
b. False 

2. Which of these statements is/are incorrect? Choose all that apply. 
a. If no one knows the password to a password protected database, the database can’t be 

recovered. 
b. Crea:ng an executable file for a database creates the same level of protec:on an 

encryp:ng it with a password. 
c. The three methods of processing a database are by encryp:ng it with a password, by 

crea:ng an executable file, and by saving it as an ACCDBPW file. 
d. Although executable files aren’t considered as strongly encrypted as password protected 

files, they do keep users from opening, dele:ng, or modifying your VBA code, forms, and 
reports. 

3. True or false? If you decide to back up your database, you can use the Database Documenter to 
recreate a database and all its objects. 

a. True 
b. False 
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